
 2015-2016 Microchip Technology Inc. DS50002367B

PAC1710 and PAC1720
High-Side Current Sensors

Evaluation Board
User’s Guide



DS50002367B-page 2  2015-2016 Microchip Technology Inc.

Information contained in this publication regarding device
applications and the like is provided only for your convenience
and may be superseded by updates. It is your responsibility to
ensure that your application meets with your specifications.
MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR
IMPLIED, WRITTEN OR ORAL, STATUTORY OR
OTHERWISE, RELATED TO THE INFORMATION,
INCLUDING BUT NOT LIMITED TO ITS CONDITION,
QUALITY, PERFORMANCE, MERCHANTABILITY OR
FITNESS FOR PURPOSE. Microchip disclaims all liability
arising from this information and its use. Use of Microchip
devices in life support and/or safety applications is entirely at
the buyer’s risk, and the buyer agrees to defend, indemnify and
hold harmless Microchip from any and all damages, claims,
suits, or expenses resulting from such use. No licenses are
conveyed, implicitly or otherwise, under any Microchip
intellectual property rights unless otherwise stated.

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specification contained in their particular Microchip Data Sheet.

• Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the 
intended manner and under normal conditions.

• There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our 
knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data 
Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

• Microchip is willing to work with the customer who is concerned about the integrity of their code.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not 
mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our
products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Microchip received ISO/TS-16949:2009 certification for its worldwide 
headquarters, design and wafer fabrication facilities in Chandler and 
Tempe, Arizona; Gresham, Oregon and design centers in California 
and India. The Company’s quality system processes and procedures 
are for its PIC® MCUs and dsPIC® DSCs, KEELOQ® code hopping 
devices, Serial EEPROMs, microperipherals, nonvolatile memory and 
analog products. In addition, Microchip’s quality system for the design 
and manufacture of development systems is ISO 9001:2000 certified.

QUALITY MANAGEMENT  SYSTEM 
CERTIFIED BY DNV 

== ISO/TS 16949 == 

Trademarks

The Microchip name and logo, the Microchip logo, AnyRate, 
dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, KeeLoq, 
KeeLoq logo, Kleer, LANCheck, LINK MD, MediaLB, MOST, 
MOST logo, MPLAB, OptoLyzer, PIC, PICSTART, PIC32 logo, 
RightTouch, SpyNIC, SST, SST Logo, SuperFlash and UNI/O 
are registered trademarks of Microchip Technology 
Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, 
ETHERSYNCH, Hyper Speed Control, HyperLight Load, 
IntelliMOS, mTouch, Precision Edge, and QUIET-WIRE are 
registered trademarks of Microchip Technology Incorporated 
in the U.S.A.

Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, 
BodyCom, chipKIT, chipKIT logo, CodeGuard, dsPICDEM, 
dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, 
EtherGREEN, In-Circuit Serial Programming, ICSP, Inter-Chip 
Connectivity, JitterBlocker, KleerNet, KleerNet logo, MiWi, 
motorBench, MPASM, MPF, MPLAB Certified logo, MPLIB, 
MPLINK, MultiTRAK, NetDetach, Omniscient Code 
Generation, PICDEM, PICDEM.net, PICkit, PICtail, 
PureSilicon, RightTouch logo, REAL ICE, Ripple Blocker, 
Serial Quad I/O, SQI, SuperSwitcher, SuperSwitcher II, Total 
Endurance, TSHARC, USBCheck, VariSense, ViewSpan, 
WiperLock, Wireless DNA, and ZENA are trademarks of 
Microchip Technology Incorporated in the U.S.A. and other 
countries.

SQTP is a service mark of Microchip Technology Incorporated 
in the U.S.A.

Silicon Storage Technology is a registered trademark of 
Microchip Technology Inc. in other countries.

GestIC is a registered trademarks of Microchip Technology 
Germany II GmbH & Co. KG, a subsidiary of Microchip 
Technology Inc., in other countries. 

All other trademarks mentioned herein are property of their 
respective companies.

© 2015-2016, Microchip Technology Incorporated, Printed in 
the U.S.A., All Rights Reserved. 

ISBN: 978-1-5224-0593-1



Object of Declaration: PAC17X0 High-Side Current Sensors Evaluation Board
 2015-2016 Microchip Technology Inc. DS50002367B-page 3



NOTES:
DS50002367B-page 4  2015-2016 Microchip Technology Inc.



PAC17X0 HIGH-SIDE CURRENT
SENSORS EVALUATION
BOARD USER’S GUIDE
Table of Contents
Preface ........................................................................................................................... 7
Introduction............................................................................................................ 7

Document Layout .................................................................................................. 7

Conventions Used in this Guide ............................................................................ 8

Warranty Registration............................................................................................ 8

Recommended Reading........................................................................................ 9

The Microchip Website.......................................................................................... 9

Product Change Notification Service..................................................................... 9

Customer Support ................................................................................................. 9

Document Revision History ................................................................................. 10

Chapter 1. Product Overview
1.1 Introduction ................................................................................................... 11
1.2 PAC17X0 Device Features .......................................................................... 11
1.3 What is the PAC17X0 High-Side Current Sensors Evaluation Board? ........ 12
1.4 What the PAC17X0 High-Side Current Sensors Evaluation Board Kit 

Contains? ............................................................................................... 13

Chapter 2. Installation and Operation
2.1 Getting Started ............................................................................................. 15

2.1.1 System Requirements ............................................................................... 15
2.1.2 Installing the Evaluation Board .................................................................. 15

Chapter 3. Hardware Description
3.1 Introduction ................................................................................................... 23

3.1.1 PAC1710 and PAC1720 ............................................................................ 23
3.1.2 Power Source ............................................................................................ 23

3.2 USB-to-SMBus Bridge .................................................................................. 23
3.2.1 Direct SMBus Connect Option .................................................................. 23

3.3 LED Indicators .............................................................................................. 24
3.4 Jumper Settings ........................................................................................... 25
3.5 PAC17X0 Test Points ................................................................................... 27
3.6 Demo Mode Setup and Operation ................................................................ 28

3.6.1 Steady-State Current Source .................................................................... 28
3.6.2 10 Hertz Current Source ........................................................................... 29
3.6.3 Pulse Current Source ................................................................................ 30

3.7 Sys Mode Setup and Operation ................................................................... 31
3.7.1 Jumper Positions ....................................................................................... 31
3.7.2 Load Connection ....................................................................................... 31

3.8 Measurement Polarity .................................................................................. 32
 2015-2016 Microchip Technology Inc. DS50002367B-page 5



PAC17X0 High-Side Current Sensors Evaluation Board User’s Guide
Chapter 4. Software Description
4.1 Chip Manager Application Overview ............................................................ 33

4.1.1 Real-Time Register Graphs .......................................................................33
4.1.2 Selecting Registers to Plot .........................................................................34
4.1.3 Starting the Plots ........................................................................................35
4.1.4 Exporting and Importing the Plot Data .......................................................35

Chapter 5. Evaluation Board Demonstration
5.1 Introduction ................................................................................................... 37
5.2 Steady-State Current Source – Rotary Switch 1 .......................................... 37
5.3 Momentary Pulse Current Source (Amplitude) – 

Rotary Switch 2 ...................................................................................... 39
5.4 Momentary Pulse Current Source (Duration) – Rotary Switch 2 .................. 40
5.5 10 Hz Pulse Train Current Source – Rotary Switch 5 .................................. 40

Appendix A. Schematic and Layouts
A.1 Introduction .................................................................................................. 41
A.2 Board – Schematic: Current Sensors .......................................................... 42
A.3 Board – Schematic: Current Sources  ......................................................... 43
A.4 Board – Schematic: MCP2221 USB Bridge ................................................. 44
A.5 Board – Top Silk .......................................................................................... 45
A.6 Board – Top Copper and Silk ....................................................................... 46
A.7 Board – Top Copper .................................................................................... 47
A.8 Board – Bottom Copper ............................................................................... 48
A.9 Board – Bottom Copper and Silk ................................................................. 49
A.10 Board – Bottom Silk ................................................................................... 50

Appendix B. Bill of Materials (BOM)

Worldwide Sales and Service .....................................................................................54
DS50002367B-page 6  2015-2016 Microchip Technology Inc.



PAC17X0 HIGH-SIDE CURRENT
SENSORS EVALUATION

BOARD USER’S GUIDE

Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
PAC17X0 High-Side Current Sensors Evaluation Board. Items discussed in this 
chapter include:

• Document Layout
• Conventions Used in this Guide

• Warranty Registration

• Recommended Reading
• The Microchip Website
• Customer Support
• Document Revision History

DOCUMENT LAYOUT
This document describes how to use the PAC17X0 High-Side Current Sensors 
Evaluation Board as a development tool to emulate and debug firmware on a target 
board. The manual layout is as follows:

• Chapter 1. “Product Overview” – Important information about the PAC17X0 
High-Side Current Sensors Evaluation Board. 

• Chapter 2. “Installation and Operation” – Includes instructions on installing and 
starting the Microchip Chip Manager application.

• Chapter 3. “Hardware Description” – Shows hardware details of the PAC17X0 
High-Side Current Sensors Evaluation Board.

• Chapter 4. “Software Description” – Describes the main operations in the 
Microchip Chip Manager software.

• Chapter 5. “Evaluation Board Demonstration” – Highlights several experiments 
with the PAC17X0 High-Side Current Sensors Evaluation Board.

• Appendix A. “Schematic and Layouts” – Shows the schematic and layout 
diagrams for the PAC17X0 High-Side Current Sensors Evaluation Board.

• Appendix B. “Bill of Materials (BOM)” – Lists the parts used to build the 
PAC17X0 High-Side Current Sensors Evaluation Board.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics, to open a list of available online help files.
 2015-2016 Microchip Technology Inc. DS50002367B-page 7
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. 
Sending in the Warranty Registration Card entitles users to receive new product 
updates. Interim software releases are available at the Microchip website.

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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Preface
RECOMMENDED READING

This user’s guide describes how to use the PAC17X0 High-Side Current Sensors 
Evaluation Board. Other useful documents are listed below. The following Microchip 
document is available and recommended as a supplemental reference resource:

PAC1710/20 Data Sheet (DS20005386)

This data sheet describes the operation and features of the PAC1710/20 devices which 
have a single and dual high-side current-sense monitor with power calculation.

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. Acces-
sible by using your favorite Internet browser, the website contains the following infor-
mation:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

PRODUCT CHANGE NOTIFICATION SERVICE 

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notifications whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip website at www.microchip.com, click on Product 
Change Notification and follow the registration instructions.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the website at: 
http://www.microchip.com/support.
 2015-2016 Microchip Technology Inc. DS50002367B-page 9
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DOCUMENT REVISION HISTORY

Revision B (May 2016)

The following is the list of modifications:

• Updated the Steady-State Current Consumption table header in section 
Section 3.6.1 “Steady-State Current Source”.

Revision A (July 2015)

• Initial Release of this Document.
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Chapter 1.  Product Overview
1.1 INTRODUCTION

The PAC17X0 High-Side Current Sensors Evaluation Board provides an easily-accessible 
platform to test the various features of the PAC17X0. The System Management Bus 
(SMBus) communication is accomplished using a Universal Serial Bus (USB) bridge, which 
provides a standard interface for the application code interface. The evaluation board 
supports communication with both the PAC1710 and PAC1720 devices that are populated 
on the board. The SMBus address of the PAC1710 is set by R4 and the PAC1720 SMBus 
address is selectable with the J12 jumper.

1.2 PAC17X0 DEVICE FEATURES
The PAC1710 and PAC1720 are I2C/SMBus devices that provide high-side, 
bidirectional current sensing with precision voltage measurement capabilities. The 
devices are similar, except that the PAC1710 contains one current sensing circuit and 
the PAC1720 contains two. Both devices measure the voltage developed across an 
external sense resistor to represent the high-side current of a battery or voltage 
regulator. They also measure the SENSE+ pin voltage and use these measured values 
to present a proportional average power calculation. Current sensing includes Fault 
protection. During a Fault, the ALERT pin can be asserted or masked.

The PAC17X0 High-Side Current Sensors Evaluation Board provides users with the 
means to exercise device functionality while connected either to target systems 
(Sys mode) or while utilizing on-board sources (Demo mode). On-board sources 
include bus power, selectable steady-state current, adjustable low-frequency square 
wave current signal, and a test current pulse with selectable amplitude and duration.
 2015-2016 Microchip Technology Inc. DS50002367B-page 11



PAC17X0 High-Side Current Sensors Evaluation Board User’s Guide
1.3 WHAT IS THE PAC17X0 HIGH-SIDE CURRENT SENSORS EVALUATION 
BOARD?

All functions of the PAC17X0 devices can be tested and observed using the 
USB-based PAC17X0 High-Side Current Sensors Evaluation Board. Figure 1-1 shows 
the block diagram of this board.

FIGURE 1-1: PAC17X0 High-Side Current Sensors Evaluation Board Block Diagram.

The evaluation system is comprised of the PAC17X0 High-Side Current Sensors 
Evaluation Board and the Microchip Chip Manager application. The PAC17X0 
High-Side Current Sensors Evaluation Board has the following features:

• Test points and LEDs for monitoring on-board function

• Screw terminal connections for monitoring external system current up to 20A

• Multiple on-board adjustable current sources (steady state, square wave, 
test pulse)

• USB-to-SMBus bridge for power and communications

• Capability to connect directly to external SMBus master

The user can perform the following operations using the Chip Manager application:

• Viewing and changing register values

• Saving settings of all registers, allowing for quick configuration at a later time

• Graphing of any register

PAC1720

SMBus
Connector

SMBus
Address Select

PAC1710

System
I-source

System
I-source

System
I-load

System
I-load

EVB
I-source

EVB
I-source

EVB
I-load

EVB
I-load

VDD

SENSE

USB-to-SMBus Bridge USB Connector

ALERT

SMBus

VDDSMBus #ALERT

ADDR_SELSENSE1 SENSE2

Channel2Channel1

Rsys

Rdemo

Rsys

Rdemo

ALERT
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Product Overview
The evaluation board is designed for ease of use and experimentation purposes. 
Figure 1-2 shows the top silk screen of the PAC17X0 High-Side Current Sensors 
Evaluation Board. 

FIGURE 1-2: PAC17X0 High-Side Current Sensors Evaluation Board – Top Silk Screen.

1.4 WHAT THE PAC17X0 HIGH-SIDE CURRENT SENSORS EVALUATION 
BOARD KIT CONTAINS?

This PAC17X0 High-Side Current Sensors Evaluation Board kit includes:

• PAC17X0 High-Side Current Sensors Evaluation Board (ADM00494)

• Supplied USB-A Male to Mini USB-B Male Cable

• Information Sheet
 2015-2016 Microchip Technology Inc. DS50002367B-page 13



PAC17X0 High-Side Current Sensors Evaluation Board User’s Guide
NOTES:
DS50002367B-page 14  2015-2016 Microchip Technology Inc.



PAC17X0 HIGH-SIDE CURRENT
SENSORS EVALUATION

BOARD USER’S GUIDE

Chapter 2.  Installation and Operation
2.1 GETTING STARTED

2.1.1 System Requirements

To use the PAC17X0 High-Side Current Sensors Evaluation Board, the following are 
required:

• A PC running Microsoft® Windows® operating system

• A display resolution of 800x600 or larger, for viewing several windows 
simultaneously

• An available USB port

2.1.2 Installing the Evaluation Board

Follow the next steps to install the Microchip Chip Manager application:

1. Before installing and running the Chip Manager, install the “MCP2200/MCP2221 
Windows Driver & Installer” on the local machine. If the driver and installer 
package has already been installed, skip this step. The “MCP2200/MCP2221 
Windows Driver & Installer” can be downloaded from: 
http://www.microchip.com/wwwproducts/Devices.aspx?product=MCP2221. 
Follow the on-screen instructions to complete the installation process.

2. Download the zip file for the ChipMan program from www.microchip.com (search 
for “ChipMan” in the search box and choose version v4.16.7). Unzip the archive. 
The application’s revision history and install/uninstall notes may be found in the 
readme.txt file. 

3. To install the Chip Manager application and the device driver on the PC, run 
ChipMan-v4.16.7-windows-installer.exe.

4. Connect the supplied USB cable to an available USB port on the PC. Plug the 
mini-B end of the USB cable into the board connector, J14. The LEDs for 
VDD_Power, USB_Power, USB_OK and ALERT (LD5) should illuminate, and 
the 10 Hz LED (LD7) will blink. For a description of the LEDs, see 
Section 3.3 “LED Indicators”.

5. If the USB bridge driver has not previously been installed on the selected USB 
port, the Driver Software Installation window pops up, prompting for the driver 
install (see Figure 2-1).
 2015-2016 Microchip Technology Inc. DS50002367B-page 15
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FIGURE 2-1: Driver Software Installation Window.

6. After the driver installation is complete, the initial setup screen for the Chip 
Manager application appears (see Figure 2-2). Click Next to start the installation.

FIGURE 2-2: Application Install Window.
DS50002367B-page 16  2015-2016 Microchip Technology Inc.
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7. To proceed with the installation, read the License Agreement and accept by clicking 
the radio button corresponding to “I accept the agreement”. Then click Next.

FIGURE 2-3: License Agreement Dialog.

8. On the Installation Directory dialog, browse for the desired location or click Next 
to install in the default location (see Figure 2-4).

FIGURE 2-4: Installation Directory Dialog.
 2015-2016 Microchip Technology Inc. DS50002367B-page 17
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FIGURE 2-5: Ready to Install Dialog.

FIGURE 2-6: Setup Window – Installation Progress.

9. After the setup is complete, the MSXML Parser used by the Chip Manager 
software is installed, as shown in Figure 2-7. Once the setup completes 
successfully, press Finish to exit the install.
DS50002367B-page 18  2015-2016 Microchip Technology Inc.
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FIGURE 2-7: MSXML Parser Install Window.

FIGURE 2-8: Installation Complete Dialog.
 2015-2016 Microchip Technology Inc. DS50002367B-page 19
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10. Start the software by either going to Windows Start button > All Programs > 
Microchip > Microchip Chip Manager or by double-clicking the software icon 
( ) on the desktop. The evaluation board software will initialize and the 
Microchip Chip Manager with the Quick Help screen appears (see Figure 2-9). 

FIGURE 2-9: Microchip Chip Manager – Quick Help Window.
DS50002367B-page 20  2015-2016 Microchip Technology Inc.
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11. If a message stating that no device has been selected appears, click Yes to 
select a device. Alternatively, go to the Chip Manager’s main menu, select 
Options > Select Device. In either case, the Select Microchip Device window 
displays, as shown in Figure 2-10.

In the “Device” list, choose PAC17X0. The “Master Controller” drop-down list 
should highlight “USB SMBus Bridge”. Click OK to complete the device selection.

FIGURE 2-10: Select Device Window.

PAC17x0
 2015-2016 Microchip Technology Inc. DS50002367B-page 21
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12. From the Chip Manager main menu, ensure that Options > Auto refresh Registers 
is checked. In the left panel, click the Hardware Monitor (HWM) to expand the 
content, then select any of the register groups, as shown in Figure 2-11. The 
SM_ACT LED on the board starts blinking when any of the register groups are 
selected. The register values are automatically updated every second when the 
Auto Refresh option is on. 

FIGURE 2-11: Chip Manager Register Groups.

Devices supported with PAC17X0 are listed in Table 2-1.

TABLE 2-1: PAC17X0 SUPPORTED DEVICES

Address J12 State Device

58h N/A PAC1710

98h Installed PAC1720

9Ah Open PAC1720
DS50002367B-page 22  2015-2016 Microchip Technology Inc.
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Chapter 3.  Hardware Description
3.1 INTRODUCTION

The PAC17X0 High-Side Current Sensors Evaluation Board provides the means to 
evaluate features and to view and modify registers. There are two modes of evaluation 
board current monitoring operation: 

• Demo mode: Monitors an on-board current source

• Sys mode: Monitors an external current source

LEDs indicate status information and test points are included to monitor system 
voltages with a user-provided voltmeter or oscilloscope.

3.1.1 PAC1710 and PAC1720

The PAC1710 and PAC1720 devices are SMBus-compliant, high-side, bidirectional 
current-sense monitors in a 10-pin, 3 mm x 3 mm DFN package. Communications with 
the sensor are via the SMBus. For details regarding the PAC1710 and PAC1720, refer 
to the device data sheet.

3.1.2 Power Source

This evaluation board only requires a single USB cable to operate. USB bus voltage is 
provided to the on-board test current sources and the USB-SMBus bridge. The 
USB-SMBus bridge regulates the +5V USB power to +3.3V used by the PAC1710, 
PAC1720 and other evaluation board circuitry.

3.2 USB-TO-SMBus BRIDGE 

The communication bridge on the PAC17X0 evaluation board is based on the 
MCP2221 protocol converter. The MCP2221 enables USB connectivity in applications 
that have UART and/or I2C and SMBus interfaces.

The MCP2221 USB bridge requires a driver to be installed on the computer for proper 
communication with the PAC17X0 devices. Please refer to Section 2.1.1 “System 
Requirements” to review the installation process of the MCP2221 communication driver.

3.2.1 Direct SMBus Connect Option

It is also possible to connect an external communication master to the PAC17X0:

• Remove the jumpers on J13 and connect the SMBus master to the SDA, SCL and 
ALERT pins, as well as an external supply for +3.3V. Note that a return is also 
provided on this header for convenience (GND).

• The +3.3V can be supplied by the communication bridge by leaving the +3.3V 
jumper in place and retaining the USB connection.
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3.3 LED INDICATORS
Figure 3-1 identifies the location of the LEDs.

FIGURE 3-1: LED Locations.

Table 3-1 details the LED status of the following signals: 
.

LD7
10Hz

VDD_Power

USB_OK

SM_ACT

USB_Power

LD6
Pulse

TABLE 3-1: LED STATUS INDICATORS

LED # Signal
LED Status

OFF GREEN RED

1 USB Activity No activity on USB port Activity on USB port N/A

2 SMBus Activity No activity within 
USB-SMBus bridge

N/A Activity within 
USB-SMBus bridge

3 VDD Power VDD is not present VDD is present VDD is present

4 USB Power USB power is not present USB power is present N/A

5 Alert N/A ALERT is not asserted ALERT is asserted

6 Pulse SW4 pulse trigger 
is not pressed

SW4 pulse trigger is pressed N/A

7 10 Hz (Blinking) 10 Hz test square wave source is operating N/A
DS50002367B-page 24  2015-2016 Microchip Technology Inc.



Hardware Description
3.4 JUMPER SETTINGS
Figure 3-2 identifies the jumper locations on the evaluation board.

 

FIGURE 3-2: Jumper Locations.

This evaluation board has pin headers and jumper configurations to evaluate the 
features of the PAC1710 and PAC1720 devices. Jumper settings are described in 
Table 3-2.

J12

J17

J16

J1J2 J13

J5J4 J3 J15

J9J8 J10

J7J6

J18

J19

J20

J11
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TABLE 3-2: JUMPER SETTINGS

Pin 
Header

Label Default Position Alternate Position(s)

J1, J2 VSOURCE1+, 
VSOURCE1-

External power source terminals. See Section 3.7.2 “Load Connection”.

J3, J4 DEMO SYS (1) Select Demo mode RSENSE1+/-.
Positions 3-2 are jumpered on both jumpers. 
See Section 3.6 “Demo Mode Setup and 
Operation”.

Select Sys mode RSENSE1+/-.
Positions 1-2 are jumpered on both jumpers.
See Section 3.7 “Sys Mode Setup and 
Operation”.

J5 Polarity Normal polarity of VSOURCE1.
Positions 2-4 and 1-3 are jumpered.

Reversed polarity of VSOURCE1.
Positions 1-2 and 3-4 are jumpered.

J6, J7 VSOURCE2+, 
VSOURCE2-

External power source terminals. See Section 3.7.2 “Load Connection”.

J8, J9 DEMO SYS (2) Select Demo mode RSENSE2+/-.
Positions 3-2 are jumpered on both jumpers. 
PAC1720 only. 
See Section 3.6 “Demo Mode Setup and 
Operation”.

Select Sys mode RSENSE2+/-.
Positions 1-2 are jumpered on both jumpers. 
PAC1720 only. 
See Section 3.7 “Sys Mode Setup and 
Operation”.

J10 Polarity Normal polarity of VSOURCE2.
Positions 2-4 and 1-3 are jumpered.

Reversed polarity of VSOURCE2.
Positions 1-2 and 3-4 are jumpered.

J11 GND Connect ground from external source 
for Sys mode.

J12 J12 (ADDR_SEL) Set SMBus address at power-up to 
1001_100b – 98h.
Jumper in place (closed).

Set SMBus address at power-up to 
1001_101b – 9Ah.
Jumper off (open).

J13 GND, ALERT, 
SCL, SDA, 3.3V

USB bridge generates on-board 3.3V and 
provides SMBus host.
Positions 1-2, 3-4, 5-6, 7-8, 9-10 are 
all jumpered.

See Section 3.2.1 “Direct SMBus 
Connect Option”.

J14 USB Connection USB connection for Chip Manager control and monitoring.

J15 Pulse Dur Range See Section 3.6.3 “Pulse Current Source”

J16 Demo Current 
Range Sel

80 mV range. Positions 1-2 are jumpered.
See Section 3.6.1 “Steady-State Current 
Source”.

40 mV range. Positions 3-4 are jumpered.
20 mV range. Positions 5-6 are jumpered.
10 mV range. Positions 7-8 are jumpered.

J17 VSOURCE1+ Power jacks. See Section 3.7.2 “Load Connection”.

J18 VSOURCE1-

J19 VSOURCE2+

J20 VSOURCE2-
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3.5 PAC17X0 TEST POINTS

The PAC17X0 High-Side Current Sensors Evaluation Board provides test points for 
ground reference and signal access. Table 3-3 summarizes these test points.

  

TABLE 3-3: TEST POINT LOCATION

Test Point # Marking Monitored Signal Function

1 VSENSE1+ (orange) SENSE+

2 VSENSE1- (yellow) SENSE-

3 VSENSE2+ (orange) SENSE+

4 VSENSE2- (yellow) SENSE-

5 ALERT (white) ALERT

6 ADDR_SEL (white) SMBus Address Select (at power-up)

7 10 Hz (white) Square Wave Current Output

8 PULSE (white) Momentary Pulse (SW4 pushed)

9 IDD (white) Current Monitor with 2.5V/mA Sensitivity
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3.6 DEMO MODE SETUP AND OPERATION

Demo mode uses three on-board current sources to exercise and demonstrate the 
features of the PAC1710 and PAC1720 devices. Jumpers J3, J4, J8 and J9 are initially 
set for Demo mode (see Section 3.4 “Jumper Settings”).

3.6.1 Steady-State Current Source

A constant current source is provided using +5V USB as the supply. This current is 
adjustable from zero to approximately 85 mA (80 mV range) using rotary switch, SW1 
SS Amp Adjust. Parallel sense resistors are provided for a combined value of one ohm, 
with accuracy less than or equal to 0.3%. This is used to convert the current to a cor-
responding voltage for the PAC1720 to read at the SENSE+ and SENSE- inputs. The 
steady-state current consumption for the rotary switch SW3 Pulse Duration settings, in 
conjunction with the J16 jumper position which sets the range, are shown in Table 3-4. 

TABLE 3-4: STEADY-STATE CURRENT CONSUMPTION

SW1 
Position

J16 Jumper Position

Pins 1-2
(80 mV Range)

Pins 3-4
(40 mV Range)

Pins 5-6
(20 mV Range)

Pins 7-8
(10 mV Range)

0 0 mA 0 mA 0 mA 0 mA

1 ~6.6 mA ~3.3 mA ~1.6 mA ~0.8 mA

2 ~13.2 mA ~6.6 mA ~3.2 mA ~1.7 mA

3 ~19.4 mA ~9.6 mA ~4.6 mA ~2.4 mA

4 ~26.8 mA ~13.3 mA ~6.4 mA ~3.4 mA

5 ~32.4 mA ~16.0 mA ~7.8 mA ~4.1 mA

6 ~38.1 mA ~18.9 mA ~9.1 mA ~4.8 mA

7 ~43.4 mA ~21.5 mA ~10.4 mA ~5.5 mA

8 ~53.2 mA ~26.3 mA ~12.8 mA ~6.7 mA

9 ~57.9 mA ~28.7 mA ~13.9 mA ~7.3 mA

A ~62.8 mA ~31.1 mA ~15.1 mA ~7.9 mA

B ~67.2 mA ~33.3 mA ~16.1 mA ~8.4 mA

C ~72.7 mA ~36.0 mA ~17.4 mA ~9.1 mA

D ~76.9 mA ~38.0 mA ~18.4 mA ~9.7 mA

E ~81.1 mA ~40.1 mA ~19.4 mA ~10.2 mA

F ~85.0 mA ~42.1 mA ~20.4 mA ~10.7 mA
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3.6.2 10 Hertz Current Source

Rotary switch SW5 10 Hz Amp Adjust injects a 10 Hz square wave signal into the 
current-sense measurement circuit. This function is provided to demonstrate the 
PAC1710 and PAC1720 devices’ ability to attenuate circuit noise. The steady-state 
current consumption for the rotary switch SW1 Steady-State settings, in conjunction 
with the J16 jumper position which sets the range, are shown in Table 3-4. The square 
wave amplitude is adjustable by rotary switch SW5 to obtain the pulse consumption 
shown in Table 3-5.

TABLE 3-5: 10 Hz PULSE CURRENT CONSUMPTION  

SW5 Position 10 Hz Pulse Consumption (mA)

0 0 mA

1 ~0.7 mA

2 ~1.4 mA

3 ~2.0 mA

4 ~2.8 mA

5 ~3.4 mA

6 ~4.0 mA

7 ~4.6 mA

8 ~5.6 mA

9 ~6.1 mA

A ~6.6 mA

B ~7.1 mA

C ~7.6 mA

D ~8.1 mA

E ~8.5 mA

F ~8.9 mA
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3.6.3 Pulse Current Source

The pulse current source is provided to demonstrate the PAC1710 and PAC1720 
devices’ ability to detect current spikes of varying amplitude and duration. The current 
source is activated using momentary switch SW4 Pulse Trigger. Rotary switch SW2 
Pulse Amp Adjust, in conjunction with the J15 jumper position which increases the 
dynamic range of the pulse width, sets the pulse duration as shown in Table 3-6. Single 
pulse current consumption is shown in Table 3-7.

TABLE 3-6: SINGLE PULSE DURATION

SW2 
Position

J15 Jumper Position

Pins 1-2 Pins 2-3 Open

0 ~1.38 ms ~14.68 ms ~0.176s

1 ~2.45 ms ~28.60 ms ~0.347s

2 ~3.53 ms ~42.55 ms ~0.517s

3 ~4.58 ms ~56.00 ms ~0.683s

4 ~5.73 ms ~70.60 ms ~0.862s

5 ~6.76 ms ~83.70 ms ~1.03s

6 ~7.79 ms ~96.80 ms ~1.19s

7 ~8.79 ms ~109.4 ms ~1.35s

8 ~9.74 ms ~121.6 ms ~1.50s

9 ~10.70 ms ~133.8 ms ~1.66s

A ~11.64 ms ~145.6 ms ~1.81s

B ~12.52 ms ~156.8 ms ~1.95s

C ~13.44 ms ~168.8 ms ~2.10s

D ~14.26 ms ~179.0 ms ~2.23s

E ~15.04 ms ~189.0 ms ~2.36s

F ~15.7 ms ~190.0 ms ~2.47s

TABLE 3-7: SINGLE PULSE CURRENT CONSUMPTION

SW5 Position Single Pulse Consumption (mA)

0 0 mA

1 ~2.8 mA

2 ~5.6 mA

3 ~8.2 mA

4 ~11.3 mA

5 ~13.7 mA

6 ~16.1 mA

7 ~18.4 mA

8 ~22.4 mA

9 ~24.5 mA

A ~26.5 mA

B ~28.4 mA

C ~30.7 mA

D ~32.5 mA

E ~34.3 mA

F ~35.9 mA
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3.7 SYS MODE SETUP AND OPERATION

Sys mode uses external current sources, such as 12 VDC, to exercise and demonstrate 
the features of the PAC1710 and PAC1720. 

3.7.1 Jumper Positions

To use Sys mode, adjust jumpers J3, J4, J8 and J9 (see Table 3-2) to disconnect the 
on-board demonstration current sources. 

3.7.2 Load Connection

A 3 m (1% tolerance) sense resistor is provided on-board the PAC17X0 High-Side 
Current Sensors Evaluation Board to measure system current. For VSOURCE1, this 
sense resistor is connected between J17 and J18 if using these power jacks, or between 
J1 and J2 if using wire terminals. For VSOURCE2, this sense resistor is connected between 
J19 and J20 if using these power jacks, or between J6 and J7 if using wire terminals.

When using wire terminals, connections to the system can be established as shown in 
Figure 3-3.

   

FIGURE 3-3: External Load Connection Using Wire Terminals.

J1
VSOURCE1+ Connects to

DC Load/Supply

J2
VSOURCE1- Connects to

DC Load/Supply

J7
VSOURCE2- Connects to

DC Load/Supply

J6
VSOURCE2+ Connects to

DC Load/Supply

J11
Connects to 
System Ground

Note: J17/J18 are alternate connections for VSOURCE1 and J19/J20 are alternate connections for VSOURCE2.
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3.8 MEASUREMENT POLARITY

Measurement polarity can be reversed using jumpers provided in J5 for VSOURCE1 and 
J10 for VSOURCE2. For normal polarity measurements, jumpers are placed in 
locations 1-3 and 2-4 (default). For measurement polarity reversal, jumpers are 
positioned in locations 1-2 and 3-4. 
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Chapter 4.  Software Description
4.1 CHIP MANAGER APPLICATION OVERVIEW

The Chip Manager application enables the user to display voltage readings, set bus 
voltage and current-sense limits and read/write Configuration register values. The Chip 
Manager initially displays a Quick Help screen (see Figure 2-9). For detailed 
information on application features and usage, select Help > Contents to display the 
HTML-based Help document, as shown in Figure 4-1.

FIGURE 4-1: Chip Manager Help Screen.

4.1.1 Real-Time Register Graphs

The Chip Manager software has the ability to plot register values in real time, up to a 
4 Hz continuous rate.
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4.1.2 Selecting Registers to Plot

1. To plot a register, right-click the desired register name or value. Select the “Add 
Register(s) to Plot” from the context menu (see Figure 4-2) to add the register or 
value to the plot list. 

FIGURE 4-2: Adding Registers to Plot.

2. Once the desired register is added to be plotted, a graphic plot window will 
appear with a legend on top, as shown in Figure 4-3. The two windows can be 
rearranged independently.

FIGURE 4-3: Register Plot Window.

3. To plot additional registers, go back to the Chip Manager main window and 
repeat Step 1.
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4.1.3 Starting the Plots

All plots can be started simultaneously by selecting Control > Plots > Start All Plots from 
the menu in the Main Application window. Multiple plots will be in sync if they are started 
simultaneously.

Individual plots may be paused at any time by clicking Control > Pause in the Plot 
window. This will not cause loss of captured data on the other Plot windows.

For a better view of the plot, select a different “Time per division” value in the drop-down 
menu at the bottom of the Plotting window. This scale change affects both the 
Real-Time mode and the Playback mode, while the rate at which data is recorded is 
unaffected.

4.1.4 Exporting and Importing the Plot Data

The data on each plot window may be stored in a semicolon-separated text file. To save 
the data, follow the steps:

1. Stop the plotting by selecting Control > Stop from the Plot window or 
Control > Plots > Stop All Plots from the Chip Manager main window.

2. Select File > Export from the Plot window to save the data.

To review saved data:

1. Select File > Import from an open Plot window and then select the file name to open.

Note: Before starting the plots, it is important to disable the register’s 
auto refresh. On the Chip Manager main menu, ensure that 
Options > Auto Refresh Registers is not checked.

Note: Importing a saved data file into a Plot window with a different data type is 
not allowed by the Chip Manager application. In this case, a warning 
message will display. It is recommended to choose a file name that reflects 
the data type when exporting the plot data.
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NOTES:
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Chapter 5.  Evaluation Board Demonstration
5.1 INTRODUCTION

This chapter provides insight to the PAC17X0 High-Side Current Sensors Evaluation 
Board capabilities.

5.2 STEADY-STATE CURRENT SOURCE – ROTARY SWITCH 1
Rotary Switch 1 provides a means to control the current level through the on-board 
1 sense resistor in fifteen discrete steps (see Section 3.6.1 “Steady-State Current 
Source”). To demonstrate this, complete the following steps:

1. In the Chip Manager application, select Bus Monitoring from the left pane to show 
registers. Right-click a VSENSE range and add it to the registers to plot (see 
Figure 5-1 and Section 4.1.2 “Selecting Registers to Plot”). 

FIGURE 5-1: Selecting Register to Plot.

2. Turn all rotary switches to the “0” position.

3. Go to the Control menu and start the plot. Figure 5-2 shows a plot of current with 
all switches off.

FIGURE 5-2: All Current Sources Off Plot.
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4. Turn the Rotary Switch 1 to move through positions “1” through “F” and observe 
the plot (Figure 5-3).

FIGURE 5-3: Steady-State Current Plot.

5. After experimenting, you can stop the plot and export the data (see 
Section 4.1.4 “Exporting and Importing the Plot Data”) or leave it running for 
the next demonstration.
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5.3 MOMENTARY PULSE CURRENT SOURCE (AMPLITUDE) – 
ROTARY SWITCH 2

Rotary Switches 2 and 3 can be used to generate current spikes of varying amplitude 
and duration (see Section 3.6.3 “Pulse Current Source”). To demonstrate amplitude 
changes, complete the following steps:

1. Turn all rotary switches to the “0” position.

2. Ensure J15 is open. This increases pulse width so the demonstration is easier to 
see.

3. Start the VSENSE range plot used in the previous demonstration.

4. Turn Rotary Switch 3 to position “4”.

5. Turn Rotary Switch 2 to position “1” and press Switch 4 (Pulse Trigger button).

6. Turn Rotary Switch 2 to position “2” and press Switch 4 (Pulse Trigger button).

7. Continue turning Rotary Switch 2, one position at a time, and pressing Switch 4. 
Observe the plot (Figure 5-4).

FIGURE 5-4: Momentary Pulse Amplitude Plot.

8. After experimenting, you can stop the plot and export the data (see 
Section 4.1.4 “Exporting and Importing the Plot Data”) or leave it running for 
the next demonstration.
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5.4 MOMENTARY PULSE CURRENT SOURCE (DURATION) – ROTARY SWITCH 2

Rotary Switches 2 and 3 can be used to generate current spikes of varying amplitude 
and duration. To demonstrate duration changes, complete the following steps:

1. Turn all rotary switches to the “0” position.

2. Ensure J15 is open. This increases pulse width so the demonstration is easier to 
see.

3. Start the VSENSE range plot used in the previous demonstration.

4. Turn Rotary Switch 2 to position “F” (highest level of pulse).

5. Turn Rotary Switch 3 to position “F” and press Switch 4 (Pulse Trigger button) to 
send the pulse. 

6. Turn Rotary Switch 3 to position “E” and press Switch 4 (Pulse Trigger button) to 
send the pulse.

7. Continue turning Rotary Switch 3, one position at a time, and pressing Switch 4. 
Observe the plot (Figure 5-5).

FIGURE 5-5: Momentary Pulse Duration Plot.

8. After experimenting, stop the plot.

5.5 10 Hz PULSE TRAIN CURRENT SOURCE – ROTARY SWITCH 5

Rotary Switch 5 can be used to introduce noise (see Section 3.6.2 “10 Hertz Current 
Source”). The evaluation board with the Chip Manager tool does not demonstrate the 
PAC1710 and PAC1720 devices’ ability to attenuate circuit noise because the maxi-
mum update rate of the Chip Manager is limited to 4 Hz. To see this feature, connect 
an external SMBus master to read the device quickly enough to properly see the results 
of the injected 4 Hz noise.
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Appendix A. Schematic and Layouts
A.1 INTRODUCTION

This appendix contains the following schematics and layouts for the PAC17X0 
High-Side Current Sensors Evaluation Board:

• Board – Schematic: Current Sensors

• Board – Schematic: Current Sources

• Board – Schematic: MCP2221 USB Bridge

• Board – Top Silk

• Board – Top Copper and Silk

• Board – Top Copper

• Board – Bottom Copper

• Board – Bottom Copper and Silk

• Board – Bottom Silk
 2015-2016 Microchip Technology Inc. DS50002367B-page 41
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~57.9 mA/~28.7 mA/~13.9 mA/~7.3 mA
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steady-state consumption
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single pulse
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steady-state
consumption SS AMP

ADJUSTMENT
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J15 position 1-2/2-3/no

~2.8 mA

~5.6 mA
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~26.5 mA

~28.4 mA

~30.7 mA

~32.5 mA

~34.3 mA

~35.9 mA

0 mA

0 mA

~0.7 mA

~1.4 mA

~2.0 mA

~2.8 mA

~3.4 mA

~4.0 mA

~4.6 mA

~5.6 mA

~6.1 mA
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ADJUSTMENT
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80 mV

40 mV

20 mV

10 mV

PULSE DUR
RANGE

4.7
R70

4.7
R42

4.7
R71

49.9R
R69

1 2
3 4

5 6
7 8

J16

0.1 μF
16V

C9
0.1 μF

16V

C8

1k
R40

1.9A
3

1

2

Q1

1.9A
3

1

2

Q2

1.9A
3

1

2

Q3

0.1 μF
16V

C14

0.1 μF
16V

C12

1k
R52

1k
R44

100R

R50

52.3k

R36

25.5k

R35

12.1k

R34

5.6k

R33

52.3k

R56

52.3k

R48

25.5k

R55

25.5k

R47

12.1k

R54

12.1k

R46

5.6k

R53

5.6k

R45

TP8

Pulse

TP7

10 Hz

1k
R66

1k
R43

GREEN

LD6
Pulse

GREEN

LD7
10 Hz

10 μF
10V

C10
330k
R62

52.3k
R63

10k
R65

MMBT3906
1

2

3

Q5

MMB
1

2

3

Q4

0.
C

1 1

C2 4 32 4C5

8 6

Hex

SW1

1 1

C2 4 32 4C5

8 6

Hex

SW2

1 1

C2 4 32 4C5

8 6

Hex

SW5

34

7

14

SN74LVC14A

U4B

98

7

14

SN74LVC14A

U4D

MCP6074
+B 5

-B 6

OUTB7 VSS

11

VDD

4

U5B

+5V_USB

MCP6074
+C 10

-C 9

OUTC8 O
VSS

11

VDD

4

U5C

+5V_USB

MCP6074
+D 12

-D 13

OUTD14 VSS

11

VDD

4

U5D

+5V_USB

0R
0603R19

0R
0603R32

0R
0603R75



P
A

C
17X

0 H
ig

h
-S

id
e C

u
rren

t S
en

so
rs E

valu
atio

n
 B

o
ard

 U
ser’s G

u
id

e

D
S

5
0

0
0

2
3

6
7

B
-p

a
g

e
 4

4


 2
0

1
5

-2
0

1
6

 M
icro

ch
ip

 T
e

ch
n

o
lo

g
y In

c.

220R

FB1

GND

3.92k

R20

GREEN

LD4

USB_Power

ID4

VBUS
1

GND5

D-2

D+3

0

USB MINI-B Female

J14

5V_USB

GND

GND

1

2

3 4

5

6

5.25V

D1
A.4 BOARD – SCHEMATIC: MCP2221 USB BRIDGE

+3.3V

+3.3V

ALERT#

SMBus_DATA
SMBus_CLK

1k
R21

10 μF
10V

C19

GREEN
LD3

VDD_Power

12
34

56
78

910

J13

USB_N

USB_P

USB_N
USB_P

0.47 μF 6.3V
0603C37

GND

GP1

RX
TX
USB_OK SM_ACT

SDA
SCL

RESET VUSB3.3V

MCP2221

VDD
1

GP02

GP13

RST4

UART RX5

UART TX6

GP27 GP3 8SDA 9SCL 10VUSB
11D- 12D+ 13Vss 14

U3

3.3V

1k
0603
5%

R78

RED
LD2

SM_ACT

3.3V

U
SB

_O
K

GREEN
LD1

USB_OK

1k
0603
5%

R3

3.3V

SM
_A

CT

ALERT

GND

0.1 μF 16V
0603C7

10k
0603
1%

R64
10k
0603
1%

R74

3.3V

GND

GND

2

VIN
1VOUT

3
MCP1703/3.3V
U8

GND

10 μF
10V
0805

C6

GND

0.1 μF
16V
0603

C5

GND

3.3V

3.3V

ALERT

10k
0603
1%

R29

+

10k
0603
1%

R25



Schematic and Layouts
A.5 BOARD – TOP SILK
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Schematic and Layouts
A.7 BOARD – TOP COPPER
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Schematic and Layouts
A.9 BOARD – BOTTOM COPPER AND SILK
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PAC17X0 HIGH-SIDE CURRENT
SENSORS EVALUATION

BOARD USER’S GUIDE

Appendix B. Bill of Materials (BOM)
TABLE B-1: BILL OF MATERIALS (BOM)(1)

Qty. Reference Description Manufacturer Part Number

30 C1, C3, C4, C5, 
C7, C8, C9, 
C11-C17, 
C21-C36

Cap. ceramic, 0.1 µF, 16V, 10%, 
X7R, SMD, 0603

KEMET C0603C104M3RACTU

3 C2, C18, C20 Cap. ceramic, 1 µF, 16V, 10%, X7R, 
SMD, 0603

Samsung Electro-Mechanics 
America, Inc.

CL10B105KO8NNNC

3 C6, C10, C19 Cap. ceramic, 10 µF, 10V, 20%, 
Y5V, SMD, 0805

TDK Corporation C1608X5R1C106M080AB

1 C37 Cap. ceramic, 0.47 µF, 6.3V, 10%, 
X5R, SMD, 0603

Murata Electronics® GRM188R60J474KA01D

1 CBL1 Mech. HW cable, USB-A male to 
Mini USB-B male, 3 ft., black

Katerno 10UM-02103BK

1 D1 Diode TVS array, USBLC6-2SC6, 
5.25V, SMD, SOT-23-6

STMicroelectronics™ USBLC6-2SC6

1 FB1 Ferrite, 2A, 220R, SMD, 0805 Murata Electronics BLM21PG221SN1D

6 J1, J2, J6, J7, 
J11, J12

Connector header-2.54, male, 1x2, 
gold, 5.84 MH, TH vert.

FCI Electronics 68001-202HLF

5 J3, J4, J8, J9, 
J15

Connector header-2.54, male, 1x3, 
gold, 5.84 MH, thin vert.

FCI Electronics 68000-103HLF

2 J5, J10 Connector header-2.54, male, 2x2, 
gold, 5.84 MH, thin vert.

FCI Electronics 67997-104HLF

1 J13 Connector header-2.54, male, 2x5, 
gold, 5.84 MH, thin vert.

FCI Electronics 67997-110HLF

1 J14 Connector USB Mini-B female, 
SMD, R/A

Hirose Electric Co., Ltd. UX60-MB-5ST

1 J16 Connector header-2.54, male, 2x4, 
tin, 5.84 MH, thin vert.

FCI Electronics 67996-408HLF

4 J17, J18, J19, 
J20

Connector jack power, 2.1 mm, 24V, 
5A, male, thin R/A

CUI Inc. PJ-002AH

14 JP1 Mech. HW jumper, 2.54 mm, 
1x2, handle gold

TE Connectivity, Ltd. 881545-2

4 KNOB1 Actuator knob black Grayhill Inc. 947705-021

5 LD1, LD3, LD4, 
LD6, LD7

Diode LED green, 2.2V, 25 mA, 
15 mcd, clear, SMD, 0603

Kingbright Corp. APT1608SGC

1 LD2 Diode LED red, 1.95V, 30 mA, 
700 mcd, clear, SMD, 0603

Kingbright Corp. APTD1608SURCK

1 LD5 Diode LED bIue, red, green, 2V, 
2.2V, 30 mA, 25 mA, 4-SMD

Lumex® Inc. SSL-LXA3025IGC-TR

4 PAD1, PAD2, 
PAD3, PAD4

Mech. HW rubber pad, cylindrical, 
D7.9, H5.3, black

3M SJ61A11

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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4 Q1, Q2, Q3, Q6 Transistor FET N-Ch., ZXMN2A01F, 
20V, 1.9A, 625 mW, SOT-23-3

Diodes® Incorporated ZXMN2A01FTA

2 Q4, Q5 Transistor BJT, PNP, MMBT3906, 
-40V, -200 mA, 300 mW, SOT-23-3

Central™ 
Semiconductor Corp.

CMPT3906-PST-LEAD-
FREE

7 R1, R2, R6, R7, 
R19, R32, R75

Resistor TKF, 0R, 1/10W, SMD, 
0603

NIC Components Corp. NRC06Z0TRF

2 R3, R78 Resistor TKF, 1k, 5%, 1/10W, SMD, 
0603

Panasonic® - ECG ERJ-3GEYJ102V

5 R4, R33, R38, 
R45, R53

Resistor TKF, 5.6k, 1%, 1/10W, 
SMD, 0603

Yageo Corporation RC0603FR-075K6L

7 R5, R37, R49, 
R57, R58, R68, 
R73

Resistor TKF, 24.9R, 1%, 1/10W, 
SMD, 0603

Vishay/Dale CRCW060324R9FKEA

4 R8, R9, R12, 
R17

Resistor TF, 2.21R, 0.1%, 1/16W, 
SMD, 0603

Stackpole Electronics, Inc. RNCF0603BKC2R21

2 R10, R18 Resistor TKF, 10.5R, 1%, 1/10W, 
SMD, 0603

Yageo Corporation RC0603FR-0710R5L

2 R11, R22 Resistor 0.003R, 1%, 2W, 1%, 2412 Ohmite® Manufacturing LVK25R003FER

2 R13, R50 Resistor TKF, 100R, 1%, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3EKF1000V

8 R14, R25, R29, 
R51, R64, R65, 
R74, R76

Resistor TKF, 10k, 1%, 1/10W, 
SMD, 0603

Vishay/Dale CRCW060310K0FKEA

12 R15, R16, R21, 
R26, R28, R31, 
R40, R43, R44, 
R52, R59, R66

Resistor TKF, 1k, 1%, 1/10W, SMD, 
0603

Panasonic - ECG ERJ-3EKF1001V

2 R20, R23 Resistor TKF, 3.92k, 1%, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3EKF3921V

2 R24, R41 Resistor TKF, 1M, 1%, 1/10W, SMD, 
0603

Panasonic - ECG ERJ-3EKF1004V

2 R27, R30 Resistor TKF, 100k, 1%, 1/4W, 
SMD, 0603

Stackpole Electronics, Inc. RMCF0603FT100K

4 R34, R39, R46, 
R54

Resistor TKF, 12.1k, 1%, 1/10W, 
SMD, 0603

Yageo Corporation RC0603FR-0712K1L

3 R35, R47, R55 Resistor TKF, 25.5k, 1%, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3EKF2552V

4 R36, R48, R56, 
R63

Resistor TKF, 52.3k, 1%, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3EKF5232

3 R42, R70, R71 Resistor TKF, 4.7k, 1%, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3RQF4R7V

3 R60, R67, R72 Resistor TKF, 14.3R, 1%, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3EKF14R3V

2 R61, R77 Resistor TKF, 221k, 1%, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3EKF2213V

TABLE B-1: BILL OF MATERIALS (BOM)(1) (CONTINUED)

Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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1 R62 Resistor TKF, 330k, 1%, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3EKF3303V

1 R69 Resistor TKF, 49.9R, 1%, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3EKF49R9V

4 SW1, SW2, 
SW3, SW5

Switch, Rotary HEX, 50V, 0.1A, 
94HBB16T, thin, DIP-8

Grayhill Inc. 94HBB16T

1 SW4 Switch, Tact. SPST, 15V, 20 mA, 
EVQ-PAC05R

Panasonic - ECG EVQ-PAC05R

2 TP1, TP3 Conn. TP loop, orange, thin Keystone Electronics Corp. 5013

2 TP2, TP4 Conn. TP loop, yellow, thin Keystone Electronics Corp. 5014

5 TP5, TP6, TP7, 
TP8, TP9

Conn. TP loop, white, thin Keystone Electronics Corp. 5012

1 U1 Microchip Analog 
Current-Sense Monitor, 
PAC1720-1-AIA-TR, DFN-10

Microchip Technology Inc. PAC1720-1-AIA-TR

1 U2 Microchip Analog 
Current-Sense Monitor, 
PAC1710-1-AIA-TR, DFN-10

Microchip Technology Inc. PAC1710-1-AIA-TR

1 U3 Microchip Interface USB I2C UART, 
MCP2221-I/ST, TSSOP-14

Microchip Technology Inc. MCP2221-I/ST

1 U4 IC buffer inverter, SN74LVC14ADR, 
SOIC-14

Texas Instruments SN74LVC14ADR

1 U5 Microchip Analog Op Amp, 4-Ch., 
1.2 MHz, MCP6074-E/SL, SOIC-14

Microchip Technology Inc. MCP6074-E/SL

1 U6 IC Analog op amp, 1-Ch., 300 kHz, 
MCP6V31UT-E/OT, SOT-23-5

Microchip Technology Inc. MCP6V31UT-E/OT

1 U8 Microchip Analog LDO, 3.3V, 
MCP1703T-3302E/DB, SOT-223-3

Microchip Technology Inc. MCP1703-3302E/DB

TABLE B-1: BILL OF MATERIALS (BOM)(1) (CONTINUED)

Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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